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About the Machine

Features
This machine is a hot stamping printer that uses laser light. Using foil to imprint illustrations and 
text results in high-class decorations on plastic products.
You can easily create imprint data using dedicated software.

Names of Components

Machine

Hold the middle area of the 
cover when opening the cover.

Cover

Head

Head unit

Power/Movement button

Laser pointer button

Power-cord connector

USB connector
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Head

The foil is transferred onto the material by way of the laser light irradiated from the lens. Be-
cause the lens is a consumable part, replace it at the appropriate time.

 " P.46 “Checking the Lens Service Life”

Lens

Material Retainers

Center vise

This is a vise made of plastic. This vise secures the material in place by clamping it. This makes it 
possible to immobilize material that cannot be secured using the adhesive sheet, such as items 
having a curved bottom surface.

 "  P.28 “Loading Material (Using the Center Vise)”

Grid table

This is used to fix material on a table. Material is placed on the adhesive sheet, which then 
holds the material in place. This lets you immobilize objects without having to use commercially 
available tape or the like.

 " P.32 “Loading Material (Using the Grid Table)”

Grid table

Adhesive 
sheet

About the Machine
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Light-absorbing Film

Striking the light-absorbing film with the laser light converts the light into heat. Note that if the film 
is installed with its front and back sides inverted by mistake, it will not be possible to convert the 
light to heat, so imprinting will not be performed. For details, see P.47 “Replacing the Light-ab-
sorbing Film”.

This heat transfers the foil onto the material.

A
A Material

Laser light

Foil

Light-absorbing film

Film Retainer

An adhesive sheet adhered to the bottom of the film retainer is used to secure the light-absorbing film.

Handle

Film frame

Cap screw

About the Machine

8 Chapter 1 Getting Started



Basic Operation

Switching On the Power

Procedure

Press the [Power/Movement] button.
The head moves to the left rear, and the lamp of the Power/Movement button is turned ON. 
This operation is called initialization.

Important:  When the power lamp remains blinking

An initialization error has occurred. Refer to the following section to eliminate the cause of the 
error, and then press the [Power/Movement] button again.

 " P.90 “The [Power/Movement] Button Is Blinking”

Switching Off the Power

Procedure

Hold down the [Power/Movement] button for one second or longer.

The light turns off and the power is switched off.

9Chapter 1 Getting Started



Starting the Software

Windows 10 and 7

1 Click the [Start] button.
2 Click [All Apps] ([All Programs] or [Programs] for Windows 7).
3 Click the icon for [(Name of software to use)] under the [(Name of software to 

use)] folder.
Windows 8.1

1 On the [Start] screen, click .
2 On the [Apps] screen, click [(Name of software to use)].

How to Display Help for the Software
Start the software, and then click [Help] → [Contents] from the menu.

 " P.10 “Starting the Software”

Basic Operation
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Checking Imprint Workflow

P.13 “Specifying Output Destination for METAZAStudio”

Switch on the power of the machine and select it as the output destination for the computer.

P.14 “Preparing the Material”

Check several conditions such as the material type and thickness that must be met for a material to be 
imprinted.

P.16 “Creating Imprint Data”

Create imprinting data using METAZAStudio.

P.28 “Loading Material (Using the Center Vise)”

P.32 “Loading Material (Using the Grid Table)”

Set the material on the machine.

P.36 “Making Imprints”

Output the imprint data from METAZAStudio.

Preparing for Imprinting
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Specifying Output Destination for METAZAStudio

Procedure

A Switch on the power to the machine.
 " P.9 “Switching On the Power”

B Start METAZAStudio.
 " P.16 “Starting METAZAStudio”

C Click [File] → [Set up the printer].

The [Print Setup] screen appears.

D Select the printer to which data will be output.

1 Select [DGSHAPE LD-80].
2 Click [OK].

Preparing for Imprinting
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Preparing the Material
In order for a material to be used for imprinting with this machine, the material must meet all of 
the following conditions.

Material

• Acrylic
• Polycarbonate
• Polypropylene
• Polystyrene
• ABS

Thickness

Maximum: 20 mm (0.8 in.)

Size

The material is large enough to be firmly secured.

With this machine, you can use the center vice or the adhesive sheet to secure the material. It is 
acceptable for the material to be of a size such that it protrudes from the center vice or adhesive 
sheet, but the essential requirement is that the material can be firmly secured.

Shape

There must be no unevenness on the imprint surface.

Imprinting is not possible for material that comes into contact with the moving part of the machine 
when being loaded or during imprinting.

The edge of the 
material is too high.

L-shape

Flat view:

Cross-sectional 
view:

NOT OK NOT OK

Preparing for Imprinting
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The back surface must be flat, with no difference in level. (When using the grid table)

To imprint material whose back surface is not flat, use the center vise to fix the material in place.

The back surface 
is curved.

The back surface 
is uneven.

Flat view:

Cross-sectional 
view:

OK NOT OK NOT OK

Conditions for Material When Imprinting Curved Surfaces

The table and figure below show the recommended imprint area with respect to the diameter of 
the cylinder with the extended curved surface. Note, however, that the following conditions are 
assumed.

Material with an extended curved surface has circularity.

Diameter of cylinder with 
extended curved surface 

(ϕ)
Recommended imprint area (A)

10 mm (0.4 in.) 2.0 mm (0.08 in.)
20 mm (0.8 in.) 2.8 mm (0.11 in.)
30 mm (1.2 in.) 3.4 mm (0.14 in.) 

Preparing for Imprinting
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Starting METAZAStudio

Windows 10 and 7

1 Click the [Start] button.
2 Click [All Apps] ([All Programs] or [Programs] for Windows 7).
3 Click the [METAZAStudio] icon under the [Roland METAZAStudio] folder.
Windows 8.1

1 On the [Start] screen, click .
2 On the [Apps] screen, click [METAZAStudio].

METAZAStudio starts.

Creating Imprint Data
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METAZAStudio Screen

No. Name Overview of function

1 Menu bar
Runs the various commands for METAZAStudio.

 "METAZAStudio online help (“Commands”)

2 Toolbar
The toolbar is provided with buttons for running METAZAStudio commands 
such as [Material] and [Open].

 "METAZAStudio online help (“Commands” - “Toolbar buttons”)

3 Page feed bar

When you have entered data into a variable field, use this to specify the page 
(record) that is displayed on the screen. Use this for variable imprinting.

 " P.73 “Creating Variable Imprint Data”
 "METAZAStudio online help (“Hints and Tips” > “Performing Variable Imprint-

ing”)

4 Status bar

This shows the present location of the cursor, information about the shape, 
the grid, and the view magnification. Moving the pointer to a toolbar button or 
pointing to a menu command makes a brief explanation of the button or com-
mand appear at the left edge.

Present cursor posi-
tion

This indicates the present location of the cursor. The 
position at the center of the window (where the two 
center lines intersect) is (0, 0).

Shape information

This appears when you click an on-screen object 
(image, text, or shape). The center position and size 
of the present shape are displayed, as shown in the 
figure below.

Grid pitch
This displays the pitch (spacing) of the grid lines. 
Clicking this displays menu items related to the ap-
pearance of the grid.

View scaling factor
This displays the present scaling factor for the screen 
view. Clicking this displays a menu that lets you 
change the view scaling factor.

Creating Imprint Data
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No. Name Overview of function

5 Grid table The machine’s grid table is shown here. The scale displayed represents the 
actual scale marks on the grid table.

6 Work area
This is the area in which imprinting is possible. The material size (imprint 
area) set with METAZA Driver is shown here.

 " P.86 “Changing Basic Driver Settings”

7 Center line This indicates the vertical and horizontal centers of the window.

8 Grid This is a grid of lines displayed in the work area. It serves as a guide for posi-
tioning images and text.

9 Margin

This blank area lies inside the edges of the work area and where no imprint-
ing is performed. The default setting upon installation of METAZAStudio is 
1 mm (0.04 in.). You can change the size of the margin by going to the [File] 
menu and selecting [Preferences].

 " P.19 “Step 1: Determine the Shape and Size of Material”

Creating Imprint Data
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Step 1: Determine the Shape and Size of Material
METAZAStudio has a number of different types of material preregistered. Using an example that 
uses a plate as described below, this section explains the procedure for using material with the 
same shape as the plate and with the name of “tag.”

 " P.14 “Preparing the Material”

25 mm 
(0.98 in.) 

40 mm 
(1.6 in.)

Memo

If you want to register new material, see the section given below.
 " P.83 “Registering a Wide Variety of Materials”

Procedure

A Start METAZAStudio.
 " P.16 “Starting METAZAStudio”

B Click .

The [Select Foil] screen appears.

Creating Imprint Data
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C Use the [Select Foil] screen to select the foil.
Clear the [Use printer driver settings] check box to select the foil. To use foil that is not included 
in the list, you can register the foil.

 " P.84 “Registering the Foil and Adjusting the Imprinting Power”

If you will use the METAZA Driver settings without changing them, select the [Use printer driver 
settings] check box.

D Click [OK].

E Click .

The [Material] panel appears.

Creating Imprint Data

20 Chapter 2 Imprinting



F Select the shape of the material.

1 Click the icon with the “tag” name.
2  Click .

The [Material Size] screen appears.

3 Enter the values for the size of the material.
4 Click [OK].

Creating Imprint Data
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The material you selected appears in the Edit window. The portion displayed as the material 
becomes the imprint area without change.

G Click [File] → [Preferences].

The [Preferences] screen appears.

Creating Imprint Data
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H Set the margins.

1 Set “Margin” to “1 mm” (0.04 in.).
2 Click [OK].

Important!

To imprint a flat material, make the margin at least 1 mm (0.04 in.). If the margin is set to less than 
1 mm (0.04 in.), the lens may strike the edge of the material, leading to lens damage.

Creating Imprint Data
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Step 2: Import the Image
Import an image to be imprinted.

Data Formats Supported by METAZAStudio

• JPEG format
• BMP (bitmap) format
• Files in AI or EPS format created with Illustrator version 7 or 8
• Files in AI or EPS format exported by CorelDRAW version 7 or 8

* Illustrator and CorelDRAW files are subject to a number of limitations. For details, see the 
online help for METAZAStudio.

 "METAZAStudio online help (“Hints and Tips” > “Reusing Existing Data”)

Important: Photographs are not suitable for imprinting with this machine.

Import image and text data.

Procedure

A Click .

The [Import] screen appears.

B Open the file.

1 At [Look in], select the location of the file.
2 Under [Files of type], select either [Picture file] or [Adobe Illustrator file].
3 Select the file you want.
4 Click [Open].
  

Creating Imprint Data
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The specified image is imported and displayed with the margins you set.

Memo

You can vary the arrangement of the placed image such as by changing the size or orientation or by 
adding a border.

 "METAZAStudio online help (“Hints and Tips”)

Important!

If the material has holes, take care to ensure that the image is not laid out over the holes. If you 
include the holes in the imprint area, the lens might hit the edge of the material, leading to lens 
damage.

Imprint area Imprint area

Imprint area

Imprint area

The imprint area 
lies over a hole.

No margins are 
present at the edges 
of the material.

The area to be 
imprinted extends 
beyond the material.

OK Not OK Not OK Not OK

1 mm 
(0.04 in.)

1 mm 
(0.04 in.)

Creating Imprint Data
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Step 3: Enter the Text
Type in the text to be imprinted.

Procedure

A Click .

B Enter text.

1 Click on the imprint area.
2 Enter text.
You can change the size and orientation of the typed text and fill it.

 "METAZAStudio online help (“Hints and Tips”)

Creating Imprint Data
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Step 4: Save Imprint Data
Save the imprint data to a file.

Procedure

A Click .

The [Save As] screen appears.

1 For [Save in], specify where to save the file.
2 Enter a file name.
3 Click [Save].

Creating Imprint Data
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Imprinting

Selecting Material Retainers
Decide whether to use the center vise or grid table as the retainer depending on the size and shape 
of the material. The criteria used to select the center vise or grid table are as follows:

• Center vise: The material is a size and shape that can be secured by the center vise.
• Grid table: The material has a flat bottom and is a size and shape that cannot be secured by the 

center vise.

Loading Material (Using the Center Vise)

1. Load the material onto the center vise.
When using the grid table, see P.32 “1. Load the material on the grid table.”.

A Open the cover.

B Turn the handle of the film retainer to the left.

Hold here.
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C Mount the center vise on the base table.
Place the protrusions on the bottom of the center vise into the holes on the base table.

Center vise

D Reset the vise for matching to the size and shape of the material.
You can also vary the orientation and front and back sides of the vise when using it. Use it in a way 
matched to the size and shape of the material.

 " P.107 “Center Vise Specifications”

This is suitable for clamping cylindrical material.This is suitable for clamping plate-shaped 
material.

Vise

Imprinting
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E Press the laser pointer button.
The laser light is irradiated from the laser pointer.
If the machine is idle for 5 minutes, the laser pointer is automatically turned off.

F Use the center vice to grasp the material so that the positional relationship between 
the "position of the imprint data" and the "center of the work area" in METAZAStu-
dio matches the positional relationship between the "position to be imprinted" and 
the "laser pointer."

Memo

The position to which the laser pointer points coincides with the center of the work area in 
METAZAStudio. By making the position to which the laser pointer points coincide with the cen-
ter of the area to be imprinted, you can print with the same layout as the one displayed in the 
METAZAStudio work area.

Center of work area

METAZAStudio

Imprint data position

Material

Laser pointer

Position to imprint

Important!

Remove dirt and dust from the imprint surface.

Performing imprinting without removing dirt and dust attached to the imprinting surface may 
decrease the imprint quality. Make sure to remove dirt and dust from the imprint surface before 
performing imprinting.

Imprinting

30 Chapter 2 Imprinting



G Tighten the vice with the retaining screw.
Tighten the retaining screw enough to keep the material from easily coming loose. Overtighten-
ing may damage the material.

Retaining screw

Vise

2. Place the foil on top of the material, and then cover this with the light-absorbing film.

A Place the foil on top of the material.

Important!

The foil has a front side and a back side.

Place the foil on the material such that the foil color that you want to imprint faces up.

Imprinting
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B Turn the handle of the film retainer to the right, and then gently lower this retainer.
Load the light-absorbing film so that it covers the imprint range of the material.

Important: Affix the light-absorbing film to material covered with foil.

If the light-absorbing film is not affixed to the material, the foil will not be transferred success-
fully.

Important: Use the light-absorbing film while changing the location struck by the la-
ser.

If you use the same location multiple times, the effect of converting light to heat will be re-
duced. Use the light-absorbing film by shifting its position so that unused locations are used. 
When there are no longer any unused locations, replace the light-absorbing film.

 " P.47 “A General Guide for the Service Life of the Light-absorbing Film”

C Close the cover.
 " P.36 “Making Imprints”

Loading Material (Using the Grid Table)

1. Load the material on the grid table.
When using the center vise, see P.28 “1. Load the material onto the center vise.”.

A Open the cover.

Imprinting
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B Turn the handle of the film retainer to the left.

Hold here.

C Mount the grid table onz the base table.
Place the protrusions on the bottom of the grid table into the holes on the base table.

Grid table

D Affix the adhesive sheet to the grid table.

Grid table

Adhesive sheet for grid table

Place the adhesive sheet straight within the grid table frame by aligning the sheet with the 
scale marks. Be careful not to allow any air bubbles to form between the grid table and the 
adhesive sheet.

Memo

If the adhesive force has been reduced, wash the adhesive sheet. If the adhesive sheet must be 
washed, be careful not to damage the surface such as by rubbing with too much force. Doing so 
may damage the surface and reduce its adhesive strength.

 " P.42 “Cleaning the Adhesive Sheet”

Imprinting
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E Press the laser pointer button.
If the machine is idle for 5 minutes, the laser pointer is automatically turned off.

Laser pointer button

F Load the material on the adhesive sheet.

Laser 
pointer

Material

• Load the material so that the positional relationship between the "position of 
the imprint data" and the "center of the work area" in METAZAStudio matches 
the positional relationship between the "position to be imprinted" and the "laser 
pointer."

Center of work area

METAZAStudio

Imprint data position

Material

Laser pointer

Position to imprint

• Gently press the material as if affixing it to the adhesive sheet.

Memo

The position to which the laser pointer points coincides with the center of the work area in META-
ZAStudio. By making the position to which the laser pointer points coincide with the center of the 
area to be imprinted, you can print with the same layout as the one displayed in the METAZAStudio 
work area.

Imprinting
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How to Place Material

• Place the material in a way that the center of the METAZAStudio work area comes 
to the center of the scale on the grid table.

• If the material is too large to fit in the grid table, use supports as necessary to 
keep the material horizontal.

Adhesive sheetCenter of 
METAZAStudio 
work area

Material

Center line

Center line

Important:  Remove dirt  and dust from the imprint surface.

Performing imprinting without removing dirt and dust attached to the imprinting surface may 
decrease the imprint quality. Make sure to remove dirt and dust from the imprint surface before 
performing imprinting.

2. Place the foil on top of the material, and then cover this with the light-absorbing film.

A Place the foil on top of the material.

Important!

The foil has a front side and a back side.

Place the foil on the material such that the foil color that you want to imprint faces up.

Imprinting
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B Turn the handle of the film retainer to the right, and then gently lower this retainer.
Load the light-absorbing film so that it covers the imprint range of the material.

Important: Affix the light-absorbing film to material covered with foil.

If the light-absorbing film is not affixed to the material, the foil will not be transferred success-
fully.

Important: Use the light-absorbing film while changing the location struck by the la-
ser.

If you use the same location multiple times, the effect of converting light to heat will be re-
duced. Use the light-absorbing film by shifting its position so that unused locations are used. 
When there are no longer any unused locations, replace the light-absorbing film.

 " P.47 “A General Guide for the Service Life of the Light-absorbing Film”

C Close the cover.
 " P.36 “Making Imprints”

Making Imprints
After completing “Creating Imprint Data” and “Loading the Material,” imprinting starts.

 " P.16 “Creating Imprint Data”, P.14 “Preparing the Material”

Procedure

A Click .
The [Print] screen appears.

Imprinting
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B Set and confirm the preferences below.

Name DGSHAPE LD-80

Foil Select the foil. The selection made when creating new imprint data is reflected 
in the foil setting.

Print Range

Use this option mainly for variable imprinting. (Normally, [All] is selected.) To 
restrict records* to be imprinted, specify the records (pages) that you wish to 
imprint. For example, to imprint only the 2nd to 5th records, select [Pages] and 
specify from page “2” to page “5.”

Copies
If imprinting the same material in multiple locations, specify the number of cop-
ies. For example, if you wish to imprint the front and back sides of the material, 
specify "2" as the number of copies.

*  Record: This refers to individual data included in the data for variable imprinting.
 " P.73 “Creating Variable Imprint Data”

C Click [OK].
Imprinting starts.

Memo: Imprinting multiple copies or records

The message shown in the figure will appear when imprinting begins. Wait until im-
printing is finished, and then go on to the next step.

Important: During imprinting, never open the cover.

If the cover is opened during imprinting, the imprinting will stop, which will make it impossible 
to imprint correctly.

Imprinting
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D When imprinting is finished, replace the material or change its orientation.
 " P.28 “Loading Material (Using the Center Vise)”
 " P.32 “Loading Material (Using the Grid Table)”

Important!

Make sure to align the position using the laser pointer button every time the material is replaced.

E Click [OK].
Imprinting of the next page starts.

Variable Imprinting of Only the Displayed Records

Click .
The [Print] screen appears.
The number (page number) of the record being displayed in METAZAStudio is specified as the 
page under [Print Range]. Specify [Foil] and [Copies] as necessary and click [OK] to start imprint-
ing.

Imprinting
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Step 1: Stopping Imprinting Operations

A Hold down the Power/Movement button for one second or longer.
The light slowly blinks while the transmitted imprint data is being deleted. The light turns off 
and the power is switched off.

Memo

When imprinting is paused, the head stays in the same position. The head will move to the left rear 
the next time the power is switched on.

Stopping Imprint Operations
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Step 2: Deleting Data from the Imprint Queue

Procedure

A Display the printer icon.

Windows 10 and 8.1

1 Right-click the [Start] menu on the computer.
2 Click [Control Panel].
3 Click [Devices and Printers].
Windows 7

1 Click the [Start] menu.
2 Click [Devices and Printers].

B Double-click the [DGSHAPE LD-80] icon.

C From the [Printer] menu, click [Cancel All Documents] (or [Purge Print Documents]).

D If the message shown in the figure appears, click [Yes.]

Stopping Imprint Operations
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Points to Note on Daily Care

WARNING Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause a fire.

WARNING During repairs, part replacements, and similar work, never perform any  
  operations that are not written in the user's manual.

Be sure to contact your authorized Roland DG Corporation dealer.

WARNING Perform this task with all power switches left switched off.
Otherwise sudden movement of the machine may cause injury.

• This machine is a precision device and is sensitive to dust and dirt. Be sure to carry out day-to-day 
cleaning.

• Never use solvents such as thinner, benzine, or alcohol.
• Never attempt to oil or lubricate the machine.
• Never apply silicone substances (oil, grease, spray, etc.) to the machine. Doing so may cause poor 

switch contact.

Cleaning the Body/Center Vise/Grid Table
• Use a cloth moistened with water and wrung well, and wipe the parts gently to clean them.
• The surface of the cover is easily scratched, so use a soft cloth.

Cleaning the Adhesive Sheet
Buildup of dust or the like on the grid table's adhesive sheet can reduce the sheet's adhesive force, 
making it difficult to secure material in place. If the adhesive force has been reduced, wash the 
adhesive sheet.

Adhesive sheet

Daily Care
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How to Wash

Immerse the adhesive sheet in water, and wash the sheet by gently stroking its surface. If the soil-
ing of the adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with 
water to remove all detergent completely.

Important!

Be sure to comply with the following instructions. If not, the surface of the adhesive sheet may 
become damaged, lowering the adhesiveness.

• Never scrub the adhesive sheet using a scrubbing pad or sponge.
• Never stretch or bend the adhesive sheet when washing it.

How to Dry

Allow the part to dry completely while keeping it out of direct sunlight.

Cleaning the Film Retainer
Buildup of dust or the like on the film frame's adhesive sheet can reduce the sheet's adhesive 
force, making it impossible to secure the light-absorbing film in place. If the adhesive force has 
been reduced, wash the film frame's adhesive sheet.

Adhesive sheet

How to Wash

Immerse the adhesive sheet in water, and wash the sheet by gently stroking its surface. If the soil-
ing of the adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with 
water to remove all detergent completely.

Important!

Be sure to comply with the following instructions. If not, the surface of the adhesive sheet may 
become damaged, lowering the adhesiveness.

• Never scrub the adhesive sheet using a scrubbing pad or sponge.
• Never stretch or bend the adhesive sheet when washing it.

How to Dry

Allow the part to dry completely while keeping it out of direct sunlight.

Daily Care
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Adjusting the Origin Location
If the imprinted text or image is placed at a position that does not coincide with the desired posi-
tion, the origin point of the machine has been displaced. Adjust the origin point using the method 
described below. You also have to adjust the origin point when you replace the lens.

Procedure

A Start LD-80 Head Manager.
 " P.10 “Starting the Software”

B Click [Adjust Origin].

The [Adjust Origin] screen appears.
Follow the on-screen instructions to perform adjustment.

Be sure to use the center vise.

If you use the grid table, the material may become misaligned during the work, causing the origin 
point adjustment to fail.

Adjusting
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C When you have finished, click .
The window closes.

Adjusting
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Replacing Consumable Parts

Checking the Lens Service Life
The lens is a consumable part. When the lens has reached the end of its service life, replace it.

A General Guide for the Service Life of the Lens

The guideline for replacement is after approximately 500 hours of imprinting.
A message that indicates the lens service life appears in METAZAStudio.

Click [OK] to make the message disappear. Click [Details] to make LD-80 Head Manager appear.

How to Check the State of the Lens

You can check the state of the lens using LD-80 Head Manager.

Procedure

A Start LD-80 Head Manager.
 " P.10 “Starting the Software”

B Switch on the power to the machine.
 " P.9 “Switching On the Power”

The amount of lens usage is indicated in this window. 
The level indicator increases little by little as imprint-
ing is performed.

This refreshes the screen to display the latest infor-
mation.
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Memo

The indicator for [The amount of Lens usage] in LD-80 Head Manager shows how much the lens 
has been used. The lens should be replaced in the following cases.

• The indicator is shown in red.
• Although the indicator is not shown in red, attractive imprinting is impossible or images are uneven.

A worn-out lens is not the only reason for decreased imprint quality and uneven imprint 
results. Refer to the following page to find the cause of the problem. If a worn-out lens is the 
likely cause of the problem, replace the lens with a new one.

 " P.92 “The Imprinted Image is Unattractive (It Is Uneven or Shifted)”

* Replacement lenses are sold separately. For purchasing information, contact your authorized 
Roland DG Corporation dealer or visit our website (http://www.dgshape.com/).

* For the lens replacement method, see the manual included with the replacement lens.

Replacing the Light-absorbing Film
If you use the same location multiple times, the light-absorbing effect will be reduced. Use the 
light-absorbing film by shifting its position so that unused locations are used. When there are no 
longer any unused locations, replace the light-absorbing film.

A General Guide for the Service Life of the Light-absorbing Film

The light-absorbing film has reached the end of its service life when it exhibits clear wrinkles and 
waviness due to the heat generation from repeated use or when it becomes white. When the light-
absorbing film is in a state such as that shown in the following figure, shift its position or replace 
the light-absorbing film.

Parts that become white can no 
longer absorb light, which means that 
they cannot be used for imprinting. 

Replacing Consumable Parts
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Light-absorbing Film Replacement Method

Procedure

A Lift up and turn to the left the handle of the film retainer.

Hold here.

B Remove the film frame.

Pull out this part toward you.

Loosen

Replacing Consumable Parts
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C Orient the film frame so that the adhesive sheet surface faces up.

Adhesive sheet

D Peel the light-absorbing film off the film frame.

Replacing Consumable Parts
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E Affix a new light-absorbing film.

Important: The light-absorbing film has a material side and a lens side. Affix it with 
the correct side facing up.

When the notch is in 
the bottom-right corner

Surface that contacts 
the materialSurface that contacts 

the lens

When the notch opens to the right, the 
surface that contacts the material is on top.

Light-absorbing Film

The light-absorbing film is oriented correctly if its notch opens to the right. If the notch points 
to the bottom right, orient the film so that the opposite side faces up.

OK Not  OK
Light-absorbing Film

If there are still unused locations on the original light-absorbing film, shift the position of this 
light-absorbing film and affix it to the film frame.

Memo

If the adhesive force with which the adhesive sheet affixes to the film frame has been reduced, 
clean the adhesive sheet.

 " P.43 “Cleaning the Film Retainer”

Replacing Consumable Parts
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F Orient the film frame so that the adhesive sheet surface faces down.

The part with the 
notch should be 
oriented in the 
upper-right corner.

Surface that 
contacts the lens

Light-absorbing Film

Surface that con-
tacts the material

Light-absorbing Film

G After affixing the light-absorbing film to the film frame, attach the film frame.
Insert the film frame with its protrusions and indentations aligned with the handle supports.

Tab

Handle

H Tighten the cap screw.

Replacing Consumable Parts
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Keeping Only the Required Portion of an Image (Trimming)
METAZAStudio can cut an original image to remove unneeded areas and keep just the required 
portion.
This operation is called “trimming.”

Procedure

A Import the image.
 " P.24 “Step 2: Import the Image”

B Select the image.

1 Click .
2 Click the image.

Eight trimming bars appear around the image.

C Trim the image.
Drag the trimming bar to trim the area you want to keep.

Trimming pointer

Processing Images
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Adjusting the Location, Size, or Angle of an Image

A Click .

B Adjust the position of the image.

1 Click the image.
( ■ ) appear at the four corners of the image.

2 Drag the image to adjust its location.

C Adjust the size of the image.

1 Click the image.
( ■ ) appear at the four corners of the image.

2 Drag the handles at the four corners of the image to adjust the size.

Handles

Processing Images
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D Adjust the angle of the image.

1 With the handles present at the four corners of the image, click the image a sec-
ond time.
The shape of the handles at the four corners changes to (●).

2 Line up the pointer with a handle.
The shape changes to a pointer for rotation.

3 Drag the handle to adjust the angle of the image.

Memo

• Holding down the keyboard’s SHIFT key as you drag a handle makes the angle change by 45 degrees 
at a time. Using this method can be convenient at times, such as when you want to perform rota-
tion by precisely 90 degrees.

• Trimming cannot be performed for an image whose angle has been changed. To perform trimming, 
first return the image to its original angle.

Processing Images
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Enclosing an Image in a Frame
You can change the arrangement of the imprint data by placing a frame around an image. You use 
frames registered in what’s called METAZAStudio’s “library.” The library contains a number of pre-
registered frames, and you can register new ones.

 "METAZAStudio online help (“Hints and Tips” > “Making Use of Library”)

Procedure

A Click .
The [Library] window appears.

B Insert a frame.

1 From [Group], select [Frame].
2 Select [Icon].
3 Click the [18] frame.
4 Click .

A frame is inserted into the window.

Processing Images
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C Adjust the size and location of the frame.
When the size of the frame is larger than that of the material, the result becomes as shown in 
the figure. The adjustment methods are the same as the methods for adjusting the location and 
size of an image.

 " P.54 “Adjusting the Location, Size, or Angle of an Image”

Handles

Processing Images
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Tips and Tricks for Text Layout

Changing the Location, Size, or Angle of Text
You can change the location, size, and angle of placed text just as with an image.

Procedure

A Enter text.
 " P.26 “Step 3: Enter the Text”

B Adjust the text position.

1 Click .
2 Click the laid-out text.

Eight handles appear around the text.

3 Drag the text to adjust its location.

C Adjust the size of the frame.
Drag the handles to adjust the size.
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D Adjust the angle of the text.

1 Click on the text and hold down the mouse button until the shape of the handles 
at the 4 corners changes to [●].

2 Line up the pointer with a handle.
The shape changes to a pointer for rotation.

3 Drag the handle to change the angle of the text.

Memo

Holding down the keyboard’s SHIFT key as you drag a handle makes the angle change by 45 de-
grees at a time. Using this method can be convenient at times, such as when you want to perform 
rotation by precisely 90 degrees.

Arranging Text to a Fan Layout

A Enter text.
 " P.26 “Step 3: Enter the Text”

B Click .
The [Properties] screen appears.

Tips and Tricks for Text Layout
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C Set the text placement.

1 Click the [Format] tab.
2 Select the [Align with Curve] check box.
3 Click [OK].

The layout of the text changes to a fan shape.

Tips and Tricks for Text Layout
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Laying Out Text along a Shape
Lay out text along a shape you have made using the drawing tools.

Procedure

A Create a shape.

1 Click the drawing tool.
Use  in this example.

2 In the editing window, create a shape on the material.
 "METAZAStudio online help (“Commands” - “Toolbar buttons”)

Drawing tools

B Click .
Position the pointer near the outline of the shape you created, and then click  when it ap-
pears under the pointer.

Tips and Tricks for Text Layout
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C Enter text.
 " P.26 “Step 3: Enter the Text”

The text is laid out along the shape.

Important!

Layout on an integrated polyline is not possible.
 "METAZAStudio online help (“Commands” > “[Object] menu” > “Convert to Polyline,” “Integrate Polyline”)

Filling Text
There are two ways to fill text: [Fill] and [Island Fill]. Select whichever method you desire.

Fill
Imprinting is performed without any spaces.

Island Fill
You can specify the interval between adjacent  
filling lines.

A Enter text.
 " P.26 “Step 3: Enter the Text”

B Click .

Tips and Tricks for Text Layout
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The [Properties] screen appears.

C Configure the Fill settings

1 Click the [Fill and Contour] tab.
2 Select the [Fill] check box.
3 Select [Fill] or [Island Fill].

When you select [Island Fill], you need to enter the pitch* as well.
* Pitch: Interval between adjacent filling lines

4 Click [OK].
The text is filled.

Tips and Tricks for Text Layout
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About Stroke Characters and SFEdit2

What Are Stroke Characters?

Stroke characters are line drawings created by extracting the center lines from the base font.

What Is SFEdit2?

SFEdit2 is a program for creating and editing stroke character fonts. As all stroke characters are 
made up of polylines and lines, you can add or delete anchor points and add line segments. In 
METAZAStudio, you can use the stroke character fonts that are created and edited using SFEdit2.

Creating/Editing a Stroke Character Font
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SFEdit2 Window

No. Name Overview of function

1 Menu bar
Runs the various commands for SFEdit2.

 " SFEdit2 Help (“Commands”)

2 Toolbar
The toolbar is provided with buttons for running SFEdit2 commands such as 
[Open...] and [Save].

 " SFEdit2 help (“Commands” - “Toolbar buttons”)

3 Status bar Moving the pointer to a toolbar button or pointing to a menu command dis-
plays a brief explanation of the button or command.

4 Character list This displays the list of all stroke characters. To edit a stroke character, click it.

5 Base line
This is the reference line for lining up a text string horizontally. When text is 
written horizontally, the base lines of adjacent characters are lined up along a 
horizontal line so that there is no unevenness.

6 Text box
This is a box for enclosing text. The size of the box differs according to the type 
of base font and the character. Normally you should create the text so that it 
fits inside the box.

7 Base font text This is displayed as a rough draft for editing stroke characters. A base font 
serves as the design base for a stroke character.

8 Stroke characters

These are line drawings created by extracting the center lines from the base 
font. All stroke characters can be edited by adding or deleting anchor points, 
adding line segments, and so on.

 " SFEdit2 help (“Operation Procedures” > “Step 2: Edit the shape of charac-
ter”

Creating/Editing a Stroke Character Font
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Creating a Stroke Character Font
The method of creating and saving a stroke character font is explained below.

Procedure

A Start METAZAStudio.
 "  See the setup guide for how to start the software.

B Click [Edit] → [Stroke Font] → [Run SFEdit2…].
SFEdit2 starts.

C Click [File] → [New…].
The [Select Base Font] screen appears.

D Create the stroke character.

1 Select a font to be used as the base for the stroke character font to be created.
2 Click [OK].

Creating/Editing a Stroke Character Font
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A stroke character font is automatically created.

E Click .

The [Save] screen appears.

F Enter a name for the created stroke character font and save it.

1 Enter the name of the created stroke character.
Giving a name based on the base font name allows you to easily identify the new name later. 
For example, “Arial2” is entered.

2 Click [OK].

The created stroke character font is saved.

G Click .

Creating/Editing a Stroke Character Font
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Changing Entered Characters into a Stroke Character Font
Make sure that either of the following operations is completed in advance.

Create a stroke character font before SFEdit2 is installed.

The window shown in the figure appears during installation. If you did not create a stroke character 
font at the time of installation, reinstall SFEdit2 and create a stroke character font.
 " P.95 “Installing the Software and the Electronic-format Manuals Separately”

Create a new stroke character font.

 " P.66 “Creating a Stroke Character Font”

Procedure

A Enter characters in METAZAStudio.
 " P.26 “Step 3: Enter the Text”

B Click .
The [Properties] screen appears.
If the text box containing the entered characters is not selected, you cannot select . Be sure 
to select the text box.

Creating/Editing a Stroke Character Font
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C Select the stroke character font.

1 Click the [Format] tab.
2 Select [Stroke].

The options for [Font] become limited to stroke characters.

3 Select the stroke character font.
4 Click [OK].

Entered characters are changed into stroke characters. The stroke character font selected in 3 
is used for the stroke characters.

Creating/Editing a Stroke Character Font
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Editing Stroke Characters

Procedure

A Change an input character to a stroke character.
 " P.68 “Changing Entered Characters into a Stroke Character Font”

B Begin stroke character editing.

1 Click .
2 Click the stroke character you want to edit.
Six handles appear around the stroke character.

3 Click [Edit] → [Stroke Font] → [Edit Stroke…].

SFEdit2 starts.

C From the Character List, click the stroke character you want to edit.
The stroke character you want to edit is displayed in the text box and the stroke character be-
comes editable. Change the position and shape of the stroke character.

 " SFEdit2 help (“Editing Polylines”)

Character list

Creating/Editing a Stroke Character Font
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D Close SFEdit2.

1 Click .
The selected stroke character font is overwritten with the edited details.

2 Click .
SFEdit2 closes.

The edited details are reflected in the stroke character.

Creating/Editing a Stroke Character Font
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Checking Finished Results

Use the Preview window to check the finished results.

Procedure

Click .

The Preview window appears.
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Creating Variable Imprint Data

Imprinting a different object on each material after changing part of the imprint data is called 
“variable imprinting.” When performing variable imprinting, you no longer need to create new data 
each time you load a material. You can continue to print different data without interruption.

Important!

Continuous imprinting with varying data can only be done with material that is the same composi-
tion and size.

A CSV file is required to perform variable imprinting.

You can create a CSV file using database files. For information on creating a CSV file, contact the 
administrator of the databases.

Step 1: Create a Variable Field

Memo: What is a variable f ield?

A variable field is a frame within which you can place text. With variable imprinting, data within the 
variable field is replaced with other data during imprinting.

Procedure

A Start METAZAStudio.
 " See the setup guide for how to start the software.

Select the foil on the [Select Foil] screen that appears.
If METAZAStudio is already running, click .

The [Select Foil] screen appears.

B Use the [Select Foil] screen to select the foil.
Clear the [Use printer driver settings] check box to select the foil. To use foil that is not included 
in the list, you can register the foil.

 " P.84 “Registering the Foil and Adjusting the Imprinting Power”

If you will use the METAZA Driver settings without changing them, select the [Use printer driver 
settings] check box.

C Click [OK].
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D Click the Insert Frame icon.
Click  and then .

E Drag the mouse (move it while holding down the left mouse button) diagonally 
downward on the work area* in METAZAStudio.
A variable field within which you can place text is created.
* Work area = black area on the screen

Work area

Creating Variable Imprint Data
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F Click [Object] > [Move to Center].

The center of the variable field moves to the center of the work area.

Important:  This work is important,  being related to the actual imprint 
posit ion.

In the machine, the center point of the imprint is defined as the imprint reference point. The “center 
of the work area” in METAZAStudio coincides with the reference point in the imprint operation. 
Consequently, making the “center of the variable field” coincide with the center of the work area 
means making the “center of the variable field” coincide with the “reference point in the actual 
imprint operation.”
Though you can imprint without making the center of the variable field coincide with the “refer-
ence point in imprinting operation,” making these points coincide with each other ensures the 
ease of placing text and images to be imprinted at the desired location.

Creating Variable Imprint Data
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G Click .
The [Properties] screen appears.

If the variable field is not selected, you cannot click . If you cannot click , click  and 
then click (select) the variable field.

H Configure the settings for properties including the size of the variable field.
For details on each setting, refer to the help for METAZAStudio (“Commands” > “[Object] 
menu” > “Properties” > “[Properties] dialog box”).

 " See the setup guide for how to display the software's help.

I After configuring the settings, click [OK].

Creating Variable Imprint Data
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Step 2: Place Text Inside the Variable Field

Procedure

A Click [Load CSV File].
The [Open...] screen appears.
If the “Variable Printing” window is not displayed, click .

B Specify a CSV file and click [Open].

The specified CSV file is imported into METAZAStudio.

C Drag the column title of the imported CSV file to the variable field.
Text is displayed in the variable field.

You can display each symbol in turn by clicking . If you want to change the size or location 
of the variable field, open the [Properties] screen (click ) and change the settings.

Creating Variable Imprint Data
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Imprinting on Curved Surfaces

With this machine, you can imprint curved surfaces. This section describes how to do so using 
imprinting on a semi-cylindrical material like the one shown below as an example.

50 mm (2.0 in.)10 mm 
(0.4 in.)Diameter (ϕ)  

= 20 mm (0.8 in.)

Important: Affix the light-absorbing film and the foil to the material.

It is more difficult to affix the light-absorbing film and the foil to material having a curved sur-
face than to flat material. If the light-absorbing film and the foil are not affixed to the material, 
the foil will not be transferred successfully. Therefore, use the film retainer to securely affix the 
light-absorbing film and the foil to the material.

Step 1: Set the Imprint Area
First, configure the settings for the imprint area on the material. When imprinting a curved surface, 
imprinting the entire surface of the material (as with flat material) is not possible. For this reason, 
the METAZAStudio editing window displays the imprint area instead of the material. The imprint 
area is determined by the value of the material’s diameter entered on the METAZA Driver setting 
screen.
For information about the conditions under which it is possible to imprint on material that has a 
curved surface, refer to the page indicated below.

 " P.15 “Conditions for Material When Imprinting Curved Surfaces”

Procedure

A Click [File] → [Preferences].
The [Preferences] screen appears.
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B Set the margins.

1 Set “Margin” to “0 mm” (0 in.).
2 Click [OK].

Memo

When imprinting a curved surface, the imprintable area is limited. To ensure a sufficient imprint 
area, set the margins to 0 mm (0 in.).

C Click [File] → [Set up the printer].
The [Print Setup] screen appears.

Imprinting on Curved Surfaces
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D Open the printer's properties screen.

1 Make sure [DGSHAPE LD-80] is chosen as the printer name.
2 Click [Properties].

E Enter the values for the size of the material.

1 Click the [Material] tab.
2 Enter the diameter.

In this example, set it to 20 mm (0.8 in.).

3 Select [Direction].
Select this to match the orientation of the material.

: Vertical : Horizontal

 In this example, select (vertical).

4 Click [Enter].
Under [Work Size], the value for [Width] is set automatically. In this example, set [Length] 
to 50 mm (2.0 in.).

5 Click [OK].

Imprinting on Curved Surfaces
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F Click [OK].

This concludes the configuration of the imprint area settings.

Step 2: Make Horizontal Writing on Portrait Material
After the imprint area is determined, place images and text in the area. This section explains the 
method of inputting characters horizontally on portrait material.

Procedure

A Enter the first letter.

1 Type in the text to be imprinted, and then adjust how it’s laid out.
2 Change the text size to your preferred size.

The text must fit within the imprint area.

Imprinting on Curved Surfaces
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B Rotate the input character to make it vertical.
 " P.58 “Changing the Location, Size, or Angle of Text”

C The cursor for entering text will appear.

1 Click .
2 Press the <→> key (left arrow key) on the keyboard.
The result becomes as shown in the figure.

D Input the remaining text and move the text to the desired position.
 " P.54 “Adjusting the Location, Size, or Angle of an Image”

Imprinting on Curved Surfaces
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Registering a Wide Variety of Materials

METAZAStudio includes four shapes of preregistered material. To imprint material not registered in 
METAZAStudio, first register it as a new material. This prevents the imprint area from being limited 
and the lens from being damaged as the result of hitting the edge of the material.
The following three methods are available for registering material. For detailed information about 
the procedures, refer to the online help for METAZAStudio.

 " See the setup guide for how to display the software's help.
 "METAZAStudio online help (“Hints and Tips” > “Registering Favorite Material”)

Importing a Bitmap Image
If an image the same size of the material is available, you can import the image under the following 
conditions.

• File format: Must be either BMP (bitmap) or JPEG
• Colors: Binary (black and white)
• Portions corresponding to the material must be black-filled

Scanning the Material with a Commercially Available Scanner
When no image with the same shape of the material is available, or if the shape of the material 
is complex, you can scan the material on a commercially available scanner and import the image 
produced. In this regard, the requirements are as follows.

• Scanner: Scanner that supports TWAIN_32.
• Colors: Binary (black and white—portions corresponding to the material must be black-filled)

Drawing the Shape of the Material
If the material is a square, circle, or other such simple shape, you can use the drawing tools either 
singly or in combination to draw the shape of the material and then register it.
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Registering the Foil and Adjusting the Imprinting Power

With this machine, imprinting using an imprinting power that matches the foil of the material used 
makes it possible to obtain even higher quality imprint results. METAZA Driver has pre-configured 
settings that match a number of foils, but you can also register foils and their optimal settings. In 
order to obtain better imprint results, you can also carry out later adjustment of the imprinting 
power of foils you’ve registered yourself.

Procedure

A Display the [METAZA Driver Printing Preferences] screen.
 " See the setup guide for how to display the [METAZA Driver Printing Preferences] screen.

B Select the imprint mode.

1 Click the [Image Correction] tab.
2 Select an option for [Foil] (settings a through d).
3 Select [Text] or [Others] for the imprinting mode.

Text Select this when you want to imprint text and other images with clear out-
lines.

Other

Select this when you want to create an expression based on the difference 
of density of dots by changing the resolution capability (or the degree of 
dot resolution) or when you want to increase the resolution to improve the 
roughness of small text or patterns. Click [Details] to set the image resolution 
and other settings.

 "METAZA Driver online help ("[Correction] tab")

4 Click [Details].

The [Details] window appears.
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C Configure the detailed imprint mode settings.

1 Enter a name for the foil you are registering.
2 Enter the speed and the imprinting power.
The imprint results vary according to the foil. Make adjustments to match the foil.

 "METAZA Driver online help ([Correction] tab > [Details] dialog box)

Speed

Change the imprinting speed. The speed of image (raster) imprinting will be 
the specified value. The upper limit of the imprinting speed when performing 
line-drawing imprinting is 24 mm/sec. If you specify a speed that exceeds the 
upper limit, the line-drawing imprinting speed will be set to the upper limit. 
If you specify a speed that is less than or equal to the upper limit, the line-
drawing imprinting speed will be set to the specified value.

Power--MIN Set the imprinting power of the darkest part of the image (the gray part).

Power--MAX Set the imprinting power of the brightest part of the image (the white part).

Vector--Power You can set the maximum value of the imprinting power for a line.

3 Select [Advanced].
[Advanced] is only available when [Others] is selected in 3 of Step B.

 "METAZA Driver online help ([Correction] tab > [Details] dialog box)

OutputResolution You can specify the number of dots per inch. As the number of the points 
becomes larger, the image will become more precise.

Drafting

You can skip image information in increments of one dot in order to make 
photograph images easier to see. With small text and lines, skipping informa-
tion can lead to imprinting with noticeable roughness. In this situation, set 
this option to "OFF."

4 Click [OK].

The [Details] window closes.

Registering the Foil and Adjusting the Imprinting Power
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Changing Basic Driver Settings

Procedure

A Display the printer icon.

Windows 10 and 8.1

1 Right-click the [Start] menu on the computer.
2 Click [Control Panel].
3 Click [View devices and printers] or [Devices and Printers].
Windows 7

1 Click the [Start] menu on the computer.
2 Click [Devices and Printers].

B Right-click the [DGSHAPE LD-80] icon, and then click [Printing preferences].
The [Printing Preferences] window for METAZA Driver appears. Change the settings to suit your 
needs.

C After configuring the settings, click [OK].
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Description

METAZA Driver allows you to configure the basic settings for a variety of items including the size of 
the material and the unit used for the display. The basic settings that have been configured with 
the methods previously described continue to be used.
You can also change these settings from METAZAStudio, but the changes will not be saved.

Procedure

Click [File] → [Print Setup] → [Properties].
The [METAZA Driver Printing Preferences] window appears. Configure the settings to suit your 
needs.

Changing Basic Driver Settings
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Other Operations Available with METAZAStudio

METAZAStudio includes a variety of other functions.
For information on the operation method, refer to the online help for METAZAStudio.

 " P.10 “How to Display Help for the Software”
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Troubleshooting

The [Power/Movement] Button Is Blinking

Do you lift the head when you 
turn on the power?

Because the head is lifted to the topmost position, the ma-
chine determines that the surface height of the material does 
not meet the requirements for carrying out imprinting. Switch 
off the power by holding down the [Power/Movement] button 
for one second or longer.
When switching on the power, be careful not to touch the 
head unnecessarily.

Has the lens been attached to 
the machine correctly?

Switch off the power by holding down the [Power/Movement] 
button for one second or longer. For the correct method to use 
in attaching the lens to the machine, see the manual included 
with the replacement lens.

Is the change in the height of 
the imprint surface too large?

Switch off the power by holding down the [Power/Movement] 
button for one second or longer. Check the conditions of im-
printable materials and select a material again.

P.14 “Preparing the Material”

Is the head fixed in place?

Loosen the knob, and then press the [Power/Movement] but-
ton. The error is cleared, and the power lamp is lit.

knob
loosen

The Machine Doesn't Run Even When Imprint Data Is Sent

Is the power switched on?
Make sure the Power/Movement button light is on. If it is dark, 
press the Power/Movement button to switch on the power.

P.9 “Switching On the Power”

Is the power cord connected 
correctly?

If it is not connected correctly, connect it properly.

See the setup guide for how to connect the main unit and the computer.

Is the cable used for the connec-
tion to the computer connected 
correctly?

Check if the connection cable is disconnected.
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You Cannot Select the Foil Using METAZAStudio

Is the [Use printer driver set-
tings] check box selected?

If the [Use printer driver settings] check box is selected in the 
[Select Foil] window displayed directly after METAZAStudio 
starts, you cannot select the foil. Clear the [Use printer driver 
settings] check box.

Are you using an older version 
of METAZAStudio?

Versions of METAZAStudio earlier than 2.30 do not support the 
LD-80, so you cannot select the foil. Install the latest version of 
METAZAStudio.

The Imprinted Location Isn't Where Desired

Is the material loaded at the 
correct location?

Verify that the material is loaded correctly on the center vise 
or grid table. Also verify that the laser pointer points to the 
center of the material to be imprinted and adjust the position 
as necessary.

P.28 “Loading Material (Using the Center Vise)”
P.32 “Loading Material (Using the Grid Table)”

The laser is irradiated on the 
target, but nothing is imprinted.

Does the material meet the requirements for imprinting with 
this machine?
Prepare and use imprintable material.

P.14 “Preparing the Material”

Is the origin point of the ma-
chine displaced?

If the origin point is displaced, text and images will not be 
imprinted at the desired position. Using LD-80 Head Manager, 
adjust the origin point.

P.44 “Adjusting the Origin Location”

Has the light-absorbing film 
been installed with the incor-
rect side affixed to the frame?

Imprinting will not be performed if the incorrect side of the 
light-absorbing film is affixed to the frame. When first installing 
the light-absorbing film and when replacing the light-absorbing 
film, attach it with the correct orientation.

P.47 “Replacing the Light-absorbing Film”

Are the front and back sides of 
the foil incorrect?

Place the foil on the material such that the foil color that you 
want to imprint faces up.

Is the head fixed in place?

If the head is fixed in place, imprinting may be performed with 
the lens not coming into contact with the material, which will 
result in the expected imprinting not being performed. Perform 
imprinting with the knob loosened.

knob
loosen
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The Imprinted Image is Unattractive (It Is Uneven or Shifted)

Are the settings for the foil 
correct?

Choose the loaded foil in METAZAStudio.
Even if the foil is the same, the imprinting conditions vary de-
pending on the surface status. In such cases, fine adjustment 
of the imprinting power is necessary.

P.84 “Registering the Foil and Adjusting the Imprinting Power”
P.19 “Step 1: Determine the Shape and Size of Material”See Step B

Has the lens reached the end of 
its service life?

You can check the state of the lens using LD-80 Head Manager.
If the indicator for the lens usage has reached the red part of 
the display, replace the lens with a new one.

P.46 “How to Check the State of the Lens”

Was bidirectional imprinting 
performed?

Bidirectional imprinting can shorten the imprint time, but the 
image quality may suffer. If this happens, go to the METAZA 
Driver setting window and clear the selection for [Bidirection], 
and then perform imprinting again.

METAZA Driver online help ("[Material] tab")

Can you perform imprinting by 
shifting the location that is be-
ing used on the light-absorbing 
film?

If you use the same location multiple times on the light-ab-
sorbing film, you will not be able to imprint cleanly. If the film 
has both unused locations and locations that have been used 
multiple times, uneven imprinting may occur.
Shift the location being used on the light-absorbing film so that 
an unused location covers the imprint range, and then perform 
imprinting again.

P.48 “Light-absorbing Film Replacement Method”

Is the head fixed in place?

If the head is fixed in place partway through imprinting, 
imprinting may be performed with the lens not coming into 
contact with the material, which will result in the expected 
imprinting not being performed. Perform imprinting with the 
knob loosened.

knob
loosen
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The Imprinted Image Is Always Missing at the Same Location

Is the change in the height of 
the imprint surface too large?

The change in the height of the imprint surface may be too 
large. Recheck the requirements for the material that can be 
imprinted by the machine and select a material that meets the 
requirements.

P.14 “Preparing the Material”

Can you perform imprinting by 
shifting the location that is be-
ing used on the light-absorbing 
film?

If you use the same location multiple times on the light-ab-
sorbing film, you will not be able to imprint cleanly. Shift the lo-
cation being used on the light-absorbing film so that an unused 
location covers the imprint range, and then perform imprinting 
again.

P.48 “Light-absorbing Film Replacement Method”

It Is Necessary to Remove the Unneeded Foil That Remains in Locations outside of the Imprinting Location
When foil remains in an unintended location, use cellophane tape to remove the unneeded foil.

Installing the Driver Separately
You can install METAZA Driver and the software at the same time. To install all these items at the 
same time, see the setup guide.

Procedure

A Log on to Windows as an administrator or as a member of the Administrators group.

B Insert the DGSHAPE Software Package CD into the computer's CD-ROM drive.
When the automatic playback window appears, click [Run menu.exe]. The setup menu appears 
automatically.

C Uninstall METAZA Driver if it has already been installed.
 " P.99 “Uninstalling the Driver”

Go to Step D if the driver is not installed or has been uninstalled.

D Click [Custom Install].

Troubleshooting
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E Click [Install] for METAZA Driver.

F Select [Install], select [DGSHAPE LD-80] as the model name, select [USB] as the port, 
and then click [Start].

The METAZA Driver installation starts. Proceed by following the on-screen instructions.
If the screen shown below appears during installation, click [Install].

G When the screen shown here is displayed, click [Finish].

Troubleshooting
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H Click  on the setup menu screen.

I Remove the CD from the CD-ROM drive.

J Connect the machine to the computer using the USB cable.
Use the included USB cable. Do not use a USB hub.

METAZA Driver is installed automatically.

Installing the Software and the Electronic-format Manuals Separately

Procedure

A Log on to Windows as an administrator or as a member of the Administrators group.

B Insert the DGSHAPE Software Package CD into the computer's CD-ROM drive.
When the automatic playback window appears, click [Run menu.exe]. The setup menu appears 
automatically.

C Click [Custom Install].

Troubleshooting
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D Click [Install] for the program or the Electronic-format Manuals you want to install.

For information about METAZA Driver installation, see P.93 “Installing the Driver Separately”.

E Follow the messages to install the software.
If the [User Account Control] window appears, click [Allow] to install the software.

F When installation finishes, click  on the setup menu screen.

G Remove the CD from the CD-ROM drive.

Driver Installation Is Impossible
If installation quits partway through or if the wizard does not appear when you make the con-
nection with a USB cable, METAZA Driver may not have been installed. In such cases, perform the 
following procedure. (If procedure A does not solve your problem, perform procedure B.)

Windows 10/8.1 (Procedure A)

Procedure

A Connect the machine to the computer using the USB cable, and then switch on the 
power to the machine.

B Click [Desktop].

C Right-click the [Start] button, and then click [Control Panel].

Troubleshooting
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D Click [View devices and printers] or [Devices and Printers].

E Check that the model you are using is displayed under “Unspecified.”

F Right-click the icon of the model you are using, and then click [Remove device].

G If the message "Are you sure you want to remove this device?" is displayed, click [Yes].

H Check that the icon for the model you are using is no longer displayed under “Un-
specified.”

I Temporarily disconnect the USB cable connecting the machine to the computer, and 
then reconnect these devices. If the printer icon for the machine you are using is 
displayed under “Printer,” the Windows driver has been successfully installed.

J If this does not solve the problem, perform the procedure under “Windows 10/8.1 
(Procedure B).”

Windows 10/8.1 (Procedure B)

Procedure

A Connect the machine to the computer using the USB cable, and then switch on the 
power to the machine.

B If the [Found New Hardware] window appears, click [Cancel] to close it. Disconnect 
any USB cables for printers other than this machine.

C Click [Desktop].

D Right-click the [Start] button, and then click [Device Manager].

E If the [User Account Control] window appears, click [Continue]. [Device Manager] 
appears.

F From the [View] menu, click [Show hidden devices].

G In the list, find and double-click [Printers] or [Other devices]. Click the model name 
or [Unknown device], whichever appears below the item you selected.

H From the [Action] menu, click [Uninstall].

I In the “Confirm Device Uninstall” window, click [OK]. Close [Device Manager].

J Detach the USB cable from the computer, and then restart Windows.

K Uninstall the Windows driver. Carry out the steps from step 3 on P.99 “Windows 10/8.1” to 
uninstall the driver.

L Reinstall the driver again according to the procedure in “Setup Guide” (“Installing the 
Software”) or P.93 “Installing the Driver Separately”.
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Windows 7 (Procedure A)

Procedure

A Connect the machine to the computer using the USB cable, and then switch on the 
power to the machine.

B Click the [Start] menu, and then click [Devices and Printers].

C Check that the model you are using is displayed under “Unspecified.”

D Right-click the icon of the model you are using, and then click [Troubleshooting].

E If a screen with the message "Install a driver for this device" is displayed, click [Apply 
this fix].

F If a message is displayed asking you to “Set as default printer,” click [Skip this fix].

G If the message “Troubleshooting has completed” is displayed, click [Close the trou-
bleshooter].

If the printer icon for the machine you are using is displayed under “Printer,” the Windows driver 
has been successfully installed. If this does not solve the problem, perform the procedure under 
“Windows 7 (Procedure B).”

Windows 7 (Procedure B)

Procedure

A If the [Found New Hardware] window appears, click [Cancel] to close it.

B Click the [Start] menu, and then right-click [Computer]. Click [Properties].

C Click [Device Manager]. When the [User Account Control] window appears, click 
[Continue]. [Device Manager] appears.

D From the [View] menu, click [Show hidden devices].

E In the list, find and double-click [Other devices]. Click the model name or [Unknown 
device], whichever appears below the item you selected.

F From the [Action] menu, click [Uninstall].

G In the “Confirm Device Uninstall” window, select [Delete the driver software for this 
device.], and then click [OK]. Close [Device Manager].

H Detach the USB cable from the computer, and then restart Windows.

I Uninstall the Windows driver. Carry out the steps from step 3 on P.100 “Windows 7” to 
uninstall the driver.

Troubleshooting
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J Reinstall the driver again according to the procedure in “Setup Guide” (“Installing the 
Software”) or P.93 “Installing the Driver Separately”.

Uninstalling the Driver
To uninstall METAZA Driver, perform the following procedure.

Windows 10/8.1

Procedure

* If the driver is uninstalled without following the procedure given below, there is a possibility that 
re-installation may not be possible.

A Switch off the power to the machine, and then detach the connector cable between 
the machine and the computer.

B Log on to Windows as an administrator.

C Click [Desktop].

D Right-click the [Start] button, and then click [Control Panel].

E Click [Uninstall a program] or [Programs and Features].

F Click the Windows driver for the machine to delete to select it, and then click [Unin-
stall]. If the [User Account Control] window appears, click [Allow].

G If a message prompting you to confirm deletion appears, click [Yes].

H Click [Start], and then click [Desktop].

I Open Explorer, and then open the drive and folder containing the Windows driver. (*)

J Double-click “SETUP64.EXE” (64-bit version) or “SETUP.EXE” (32-bit version).

K If the [User Account Control] window appears, click [Allow]. The setup program for 
the Windows driver starts.

L Click [Uninstall]. Select the machine to remove and click [Start].

M If it is necessary to restart your computer, a window prompting you to restart will 
appear. Click [Yes].

N After the computer has restarted, open Control Panel again, and then click [View 
devices and printers] or [Devices and Printers].
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O If you can see the icon of the machine to remove, right-click it and click [Remove 
device].
(*)
When using the CD-ROM, specify the folder as shown below. (This is assuming your CD-ROM drive 
is the D drive.)
D: \Drivers\WINX64 (64-bit version)
D: \Drivers\WINX86 (32-bit version)
If you are not using the DGSHAPE Software Package CD, go to the DGSHAPE Corporation website 
(http://www.dgshape.com/) and download the Windows driver for the machine you want to re-
move, and then specify the folder where you want to extract the downloaded file.

Windows 7

Procedure

* If the driver is uninstalled without following the procedure given below, there is a possibility that 
re-installation may not be possible.

A Before starting uninstallation of the driver, unplug the USB cable from your comput-
er.

B Log on to Windows as an administrator.

C From the [Start] menu, click [Control Panel]. Click [Uninstall a program] or [Programs 
and Features].

D Click the Windows driver for the machine to delete to select it, and then click [Unin-
stall].

E If a message prompting you to confirm deletion appears, click [Yes].

F On the taskbar, click [Start], [All Programs], [Accessories], [Run], and then [Browse].

G Choose the name of the drive or folder where the Windows driver is located. (*)

H Select “SETUP64.EXE” (64-bit version) or “SETUP.EXE” (32-bit version) and click 
[Open], and then click [OK].

I When the [User Account Control] window appears, click [Allow].

J The setup program for the Windows driver starts.

K Click [Uninstall]. Select the machine to remove and click [Start].

L If it is necessary to restart your computer, a window prompting you to restart will 
appear. Click [Yes].
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M The uninstallation finishes after the computer restarts.
(*)
When using the CD-ROM, specify the folder as shown below. (This is assuming your CD-ROM drive 
is the D drive.)
D: \Drivers\WINX64 (64-bit version)
D: \Drivers\WINX86 (32-bit version)
If you are not using the DGSHAPE Software Package CD, go to the DGSHAPE Corporation website 
(http://www.dgshape.com/) and download the Windows driver for the machine you want to re-
move, and then specify the folder where you want to extract the downloaded file.
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Moving the Machine

Important!

When moving the machine, be sure to carry out the removal/attachment procedures described 
below. Moving the machine without doing so may result in damage to the machine.

Step 1: Removing the Material Retainer from the Machine

Procedure

A Make sure the power is switched off.

B Open the cover of the machine.

C Remove the grid table or center vise if it has been attached.
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D Loosen the cap screw.

Loosen

E Remove the film frame from the film retainer.
Pull out this part toward you.

F Remove the cap screw.

Moving the Machine
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G Remove the film retainer from the machine.

Film Retainer

Moving the Machine
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Step 2: Attaching the Retainers
For the storage locations of the retainers, see the setup guide.

Procedure

A Hold down the Power/Movement button for ten seconds or longer when the power 
is off.
The head moves as shown below.
 

B Remove the power cord and USB cable.

C Lift the head to the highest position, and then fix it in place with the knob.

Moving the Machine

105Chapter 5 Appendix



D Attach the retainers.
Secure the machine in three locations with retainers and screws. Attach all the retainers and 
tighten the screws with the included hexagonal wrench. For details on the storage locations of 
the retainers and retaining screws, see the setup guide.

Items used Retainer

Hexagonal wrench Retainer (2) Cap screw (for use with a retain-
er; 5)

E Close the cover of the machine.

F Repack the machine.
When moving the machine, be sure to support it at the bottom using two hands. Attempting to 
move the machine by holding it at a different location may result in damage.

Moving the Machine
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Center Vise Specifications
The maximum width of loadable material is 50 mm (2.0 in.).
Change the loading orientation and fix in place the material in a way that matches its size.

120 mm (4.7 in.)

50 mm 
(2.0 in.)

93.5 mm 
(3.7 in.)

Imprint Area

Maximum Imprinting Area and Recommended Imprinting Area

Center line

Center line

Top view of the grid table

80 mm (3.2 in.)

50 mm 
(2.0 in.)

50 mm 
(2.0 in.)

80 mm 
(3.2 in.)

Recommended imprint area
(50 mm × 50 mm (2.0 in. × 2.0 in.))

Unimprintable area (5 mm 
× 10 mm [0.2 in. × 0.4 in.])
For safety, it is not possible 
to imprint in this area.

Maximum imprint area (80 mm × 80 
mm (3.2 in. × 3.2 in.))
The settings must be configured 
through METAZA Driver.
If an image exceeds the recommended 
imprint area, the imprint result might 
become uneven. 

Main Unit Specifications
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Locations of the Power Rating and Serial Number Labels

Power Rating
Use an electrical outlet that meets the 
requirements for voltage, frequency, and 
amperage given here.

Back surface

Serial number
This is required when you seek mainte-
nance, servicing, or support. Never peel off 
the label or let it get dirty.

Power Rating
Use an electrical outlet that meets the 
requirements for voltage, frequency, and 
amperage given here.

AC adapter

Main Unit Specifications
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Specifications

LD-80

Imprintable material Acrylic, Polycarbonate, Polypropylene, Polystyrene and ABS

Loadable material 
size

Maximum 100 mm (width) × 200 mm (length) × 20 mm (thickness) (3.9 in. × 7.9 
in. × 0.8 in.)
or 180 mm (width) × 100 mm (length) × 20 mm (thickness) (7.1 in. × 3.9 in. × 0.8 
in.)

 " P.107 “Imprint Area”

Imprint area Maximum imprint-
able area

80 mm (width) × 80 mm (depth) (3.1 in. × 3.1 in.)

Recommended 
imprint area

50 mm (width) × 50 mm (depth) (2.0 in. × 2.0 in.)

Resolution 353 dpi (text), 1058 dpi (vector)

Imprint direction Unidirectional imprinting or bidirectional imprinting (Selectable with Windows 
driver)

Printing speed (de-
fault)

24 mm/s (0.94 in./s)

Interface USB

Power requirements Dedicated AC 
adapter

AC 100 to 240 V ±10%, 50/60 Hz

Machine DC 19 V 1.0A

Power consumption Approx. 14 W

Operating noise 70 dB (A) or less

Operating tempera-
ture

10 to 30°C (50 to 86°F)

Operating humidity 35 to 80% (no condensation)

External dimensions 286 mm (W) × 383 mm (D) × 308 mm (H) (11.3 in. (W) × 15.1 in. (D) × 12.2 in. (H))

Weight 12 kg (26.5 lb.)

Light source For imprinting (foil 
transfer)

Class 4 laser; wavelength: 450 nm; dispersion: 23 de-
grees; pulse width and repeatability: 167.5 μs, 4 kHz; 
max. output: 1.6 W

For positioning Class 1 laser, wavelength: 655 nm

Safety devices Interlock When the cover opens, the laser power supply turns off.

Cover Light-blocking cover

Included items AC adapter, power cord, USB cable, Software Package CD, setup guide, material 
retainer, film retainer, etc.
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System Requirements for USB Connection

Computer Model preinstalled with Windows 10, 8.1, or 7 (32- or 64-bit), or upgraded com-
puter originally preinstalled with Windows 7 or later

USB cable Use the included USB cable.
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